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User’s Manual
Thank you for purchasing our product. 
Carefully read this instruction manual 
before using this unit.
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Notices about this User's Manual
In order to properly use this product, please carefully read this manual before using.
T&D Corporation accepts no responsibility for any malfunction of and/or trouble with this 
product or with your computer that is caused by the improper handling of this product and 
will deem such trouble or malfunction as falling outside the conditions for free repair out-
lined in the attached warranty.

-  All rights of this User's Manual belong to T&D Corporation. It is prohibited to use, duplicate and/or 
arrange a part or whole of this User's Manual without the permission of T&D Corporation.

-  Microsoft® and Windows® are registered trademarks of Microsoft Corporation USA and are binding 
in the USA and all other countries.
Windows Vista™ is a registered trademark of Microsoft Corporation USA .

-  Vantage Pro® and Vantage Pro2™ are trademarks of Davis Instruments Corp., Hayward, CA.

-  Weather Processing System® and WPS series® are trademarks of Texas Weather Instruments Inc., 
Dallas, TX.

-  Company names and product names are trademarks or registered trademarks of each company.

-  Specifi cations, design and other contents outlined in this manual are subject to change without 
notice.

-  On screen messages in this manual may vary slightly from the actual messages.

-  Please notify the shop where you purchased this product or T&D Corporation of any mistakes, 
errors or unclear explanations in this manual. T&D Corporation accepts no responsibility for any 
damage or loss of income caused by the use of our product.

-  This product has been designed for private or industrial use only. It is not for use in situations where 
strict safety precautions are necessary such as in connection with medical equipment, whether 
directly or indirectly.

-  We are not responsible for any malfunction or trouble caused by the use of our product or by any 
problem caused by the use of measurement results of our unit. Please be fully aware of this before 
using our product.

-  Some of our products, which come under the category of strategic goods in foreign trade law, need 
the permission of the Japanese government to be exported outside of Japan.

-  Please read the warranty and provisions for free repair carefully.
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Software User's Agreement 

Disclaimers
-  Although T&D Corporation has made operational tests on our software "WS-2 for Windows® ", we 

cannot guarantee that all operations will work properly under all conditions.

- T&D Corporation shall not accept any responsibility for any damage whether direct or indirect that 
results from the usage of WS-2 for Windows®.

-  Specifi cations of WS-2 for Windows® may be subject to change and service may be terminated 
without advance notice to the user. In such a case, T&D Corporation shall not be responsible for any 
damages, whether direct or indirect, from the inability to use WS-2 for Windows®.

- T&D Corporation has no obligation to correct any defects found in WS-2 for Windows®.

Copyright
-  All copyrights WS-2 for Windows®, including all of the programs and all related documents, are the 

sole property of T&D Corporation.

-  The reprinting or redistribution for commercial purposes whether in part or in whole, in magazines or 
as a part of any product is strictly forbidden without the expressed consent of T&D Corporation. Any 
inquires concerning commercial redistribution should be directed to the Sales Department of T&D 
Corporation.

-  Please do not attempt to make any changes or modifi cations to WS-2 for Windows®.

  * WS-2 for Windows
® 

includes [Network Settings Utility] and [Multi-scale Graph].

FCC Compliance Statement for American Users
This device complies with Part 15 of the FCC Rules.
Operation is subject to following two conditions: (1) this device may not cause harmful interference. and (2) 
this device must accept any interference received, including interference that may cause undesired opera-
tion.

Note: 
- This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to part 

15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when 
the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful inter-
ference to radio communications. Operation of this equipment in a residential area is likely to cause harmful inter-
ference in which case the user will be required to correct the interference at his own expense.
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Safety Precautions and Instructions

To ensure safety be sure to obey all of the following warnings
The following items should be strictly obeyed for the safe usage of this unit, and for protecting 
yourself and other people from bodily harm and/or damage to property. Before using make sure to 
carefully read, understand and follow the safety rules and precautions for our products as outlined 
below.

Explanation of Symbols
    Explanation of Warning Symbols

WARNING DANGER: These entries are actions that absolutely under no circumstance should be taken. The taking of 
such an action may cause serious personal physical damage or death.

CAUTION These entries are actions that if taken may lead to physical injury or damage to persons or things.

    Explanation of Picture Symbols

Denotes an important warning or caution. Inside or near the symbol will appear another symbol giving details.
 (EX: Be careful of electrocution.)

Denotes a forbidden action. Inside or near the symbol will appear another symbol giving details.
 (EX: Do not use in wet areas.)

Denotes an action that you must take. Inside or near the symbol will appear another symbol giving details. 
 (EX: Unplug power plug from outlet.)

WARNING

Do not take apart, repair or modify the main unit.
This may cause fi re or electrocution.

When installing and using this product, make sure to follow all warnings and directions from your 
computer manufacturer.

If water or a foreign body enters into this unit, immediately unplug the AC adaptor and stop using.
Continued use may cause fi re or electrocution.

Do not use this unit in wet or humid places, such as a bathroom.
It may cause a fi re or other trouble including malfunction.

Store main units, AC adaptors, and LAN cables out of the reach of children.
Touching them may result in injury and it is dangerous if they are dropped.

If any smoke or strange smells are emitted from the unit, immediately pull out the AC adaptor and 
cease using it.
Continued use may cause fi re or electrocution.

Do not drop the unit, or expose the unit to a strong impact. If that happens to the unit, immediately 
remove the batteries and stop using.
Continued use may cause fi re or electrocution.

Make sure to periodically remove dust and dirt from the AC adaptor plug.
If dust is allowed to accumulate on the plug, moisture may cause poor insulation and result in fi re.

Do not unplug the AC adaptor with wet hands.
This may cause electrocution.
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CAUTION

We are not responsible for any damage, malfunction or trouble, whether direct or indirect, caused 
by the use of our product. Please be fully aware of this before using our product.

This product has been designed for private or industrial use only. It is not for use in situations 
where strict safety precautions are necessary such as in connection with medical equipment, 
whether directly or indirectly.

This unit is not waterproof.
If the unit gets dirty, wipe it with a clean cloth dipped in alcohol.

Harmful gases or chemicals may cause corrosion and/or other danger to the unit. Also, by coming 
in contact with hazardous substances, harm may occur to the people handling the unit. Therefore, 
do not use in any environment that is exposed to chemicals and harmful gases.

Make sure that the LAN cable and AC adaptor are inserted fully, so as not to cause an improper 
connection.

Condensation may occur if the unit is moved from one environment to another where the difference 
in temperature is great.
Use the unit in an environment where the ambient temperature is from 0 to 50  and the humidity is between 20% and 
80% RH (no condensation).
When using a Wireless LAN card, please follow all instructions included with the card.

Please do not insert your fi ngers or any foreign objects into the connection jacks.

To prevent damage to the unit from static electricity, remove static electricity from your body by 
touching metal around you (door knob, window frame) before touching the unit.
Static electricity may cause not only damage to the unit, but may cause breaks in or a loss of data.

Do not put anything on top of the AC adaptor. 
This may cause overheating.

Also, when unplugging the LAN cable from the main unit, do not pull the cord, but hold the 
connector to disconnect.

Do not use or store the unit in places such as listed below:
Doing so may cause electrocution, fi re and/or other adverse effects to the device and/or your 
computer.
- Areas exposed to direct sunlight

This will cause the inside of the device to become overheated and may cause fi re, deformation, and/or other damage 
including malfunction.

- Areas prone to strong magnetic fi elds
This may cause damage including malfunction.

- Areas exposed to water leakage
This may cause electrocution or other damage including malfunction.

- Areas exposed to excessive vibration
This may cause injury, malfunction, damage or loss of proper electrical contact.

- Areas that are not fl at or level
This may cause the unit to fall and result in injury and/or damage.

- Areas near fi re or exposed to excessive heat
This may cause damage including malfunction and deformation.

- Areas prone to smoke, dust and dirt
This may cause damage including malfunction.
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What is Weather Wing WS-2?

Outline
Weather Wing WS-2 allows the user to monitor real time measurements of weather data when con-
nected to a weather station (purchase separately from Davis Instruments Corp. or Texas Weather 
Instruments Inc.)
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Connection Image (Wireless LAN)

.@/:
ABC DEF

GHI JKL
MNO

PQRS TUV
WXYZ

HILD

By utilizing its built-in networking functions the WS-2 provides for easy 
access to weather data via Internet or LAN as well as the sending of 
warning e-mails.

Connection Image (Wired LAN)

By inserting a wireless LAN card in the CF card slot, it is possible 
to connect to a Wireless LAN; allowing for communication with any 
WS-2, even when placed in remote locations. 

  [Weather Stations]
Vantage PRO2™ can be purchased from Davis Instruments Corp.
Weather Processing System (WPS series)® can be purchased from Texas Weather Instruments Inc.
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Connecting to a Network

Examples of Network Connection
The following are some ways to connect a WS-2 to a network. Please select the connection method 
that suits your network environment.

NOTE:
- To avoid poor connections, be sure to push the sensor connector securely into the jack.

  [Connecting to a HUB for in-company Communication]
Connect the provided LAN cable (LN-20W) to the HUB that is connected to your computer.

  [Connecting Directly to PC for Communication]
Do not use the supplied cable; please purchase a cross LAN cable separately.

  [Connecting to a Wireless LAN]
By inserting a Wireless LAN card into the WS-2, it is possible to carry out communication in places where 
LAN wiring is diffi cult or troublesome.

NOTE:
-  Before you insert or take out the LAN card, make sure that the AC adaptor is unplugged. 
- For information and updates concerning which wireless LAN cards can be used, please contact your local T&D 

dealer or representative. 
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Internet Connection Examples
In order to connect the WS-2 to the Internet you must fi rst set up an Internet connection environ-
ment by making arrangements with a provider for a line and get a global IP address and domain. 
Also, if necessary, make all domain name server and / or router settings. 
For more details about various settings, it is best, if present, to contact the network administrator. 
To get more details about a global IP address and domain, please contact your provider. 
The following are examples of connection methods. Please select the connection method that suits 
your network environment. 

  [Using the WS-2 over the Internet]

 In order to access the WS-2 from your browser, enter the Global IP address that has been assigned 
to the WS-2 in your browser's URL bar following [http://].

 The WS-2 will be called via a router or the Internet provider.

 The WS-2 which received the access request will return data to the computer which sent the access 
request.

  [Using a Domain Name (ex: WS-2.net)]

 In order to access the WS-2 from your browser, enter the Domain Name (Ex: WS-2.net) that has 
been assigned to the WS-2 in your browser's URL bar following [http://].

 The Domain Name that was entered in the URL bar is converted by the DNS server into an IP 
address and the WS-2 is called.

 The WS-2 which received the access request will return data to the computer which sent the access 
request.
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  [Using Mail via LAN]

 The WS-2 accesses the SMTP server and sends mail to the server. 

 The SMTP server delivers the mail sent from the WS-2, according to the address, to a POP server.

 The POP server receives the delivered mail from the SMTP server and stores it in the appropriate 
mailbox for that mail address. 

 Your computer accesses the POP server where the mail is stored and receives mail in the 
compute'smailbox. 

NOTE:
- Please take note that when you are using a LAN to send and get warning mail, it is necessary to have set up a 

SMTP server (for sending) and a POP or IMAP server (for receiving) in the network. 

  [Sending Internet Mail]

The WS-2, via a router or provider, accesses an SMTP server that exists on the Internet and sends 
mail to the SMTP server. 

 The SMTP server delivers the mail sent from the WS-2, according to the address, to a POP server. 

 The POP server receives the delivered mail from the SMTP server and stores it in the appropriate 
mailbox for that mail address. 

 Your computer accesses the POP server where the mail is stored and receives mail in the comput-
er's mailbox. 

NOTE:
- In order to connect to the Internet, please make the necessary router (LAN) settings.
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Basic Functions
- With the Internal WEB Server, Use a Browser to Check Current Readings

The built-in WEB server gives you the option of putting your data on the Internet for public access.
By using the Internet connection the user can gain the freedom to manage and collect weather data from 
anywhere in the world where the Internet is available. 

- Monitor Real Time Measurments of Weather Data
The on-board software "Weather Display Live" allows users to visually check on weather data measure-
ments via PC display.  Also, by accessing the URL for the Weather Display Live, it is possible to view the 
current weather data readings anytime on your mobile phone. 

- Send Warning Notifi cations via E-mail
By making upper and lower limit settings for the WS-2, when one of the set upper or lower limits has been 
exceeded, a warning report mail can be sent via e-mail to specifi ed e-mail addresses. 

- To make use of the warning report e-mail send function, it is necessary to create an environment in order to connect 
to the Internet or to an in-company (in-house) SMTP server. 

- Automatic Sending of Recorded Data
The WS-2 incorporates a Data Sending function which allows for the automatic transmission at a certain 
time every day or at a set regular interval of recorded data as E-mail attachment.

- To make use of the warning report e-mail send function, it is necessary to create an environment in order to connect 
to the Internet or to an in-company (in-house) SMTP server. 

- As with the automatic e-mail function, it is also possible to have recorded data automatically uploaded at a set time 
or at a set interval to a specifi ed FTP server.

- Directly Insert Wireless LAN Card for Easy Wireless Connection
The WS-2 has been designed with an onboard CF card slot. By simply inserting a CF type wireless LAN 
card into the WS-2, you can use a Wireless LAN connection.

- For information and updates concerning which wireless LAN cards can be used, please contact your local T&D 
dealer or representative. 

- Notifi cation Output to External Devices Possible
The WS-2 is equipped with built-in external output terminals. It is possible to connect to an external device, 
such as alarm or light, so that a warning notifi cation can be simultaneously seen or heard onsite. 

- Management of WS-2
By using the Administration Menu displayed in the browser, it is possible to check current system settings 
and make WS-2 settings.

WS-2 for Windows
- WS-2 Settings Utility
  Network Initialization

Make all necessary network settings for WS-2.
IP Address, Subnet Mask, Login ID / Password

  Detailed Network Settings
Make detailed network settings here.
IP Address, Subnet Mask, Gateway Address, Login ID / Password, DNS Settings, Wireless LAN Settings,
Port Number, Mail Server Settings, POP Before SMTP,   IP Block, Time Difference
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Package Contents

The following items are included in the package:

Weather wing  WS-2

x 1unit

Software Set

CD-ROM  x 1

AD-0605 AD-0609

or

LAN Cable (LN-20W)

x 1

AC Adaptor x 1

Introductory Guide and Warranty

x 1
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WS-2 Part Names and Functions

[Front]

OUTPUT LED

POWER
LED

POWER  LED
 (Power Monitor LED) While the power is ON, the lamp will be on.

OUTPUT LED
 (External Output LED) When external output is ON, the lamp will be on.

[Bottom]

External Output 
Terminal

External Output Terminals 
(Warning Output) 

Contact Output. Connect to an external device to 
notify locally of a warning occurrence.
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[LEFT SIDE]     [RIGHT SIDE]

AC Adaptor Jack

Ethernet Jack

CF Interface Slot 

COM Connector

RESET button

COM Connector Connect a Weather Station here.

Ethernet Jack Connect the LAN Cable. 
 (10Base-T/100Base-TX Ethernet Connector)

AC Adaptor Jack Connect the supplied AC adaptor.

CF Interface Slot Insert a Wireless LAN Card
RESET button Press to return to the factory default settings

* For information and updates concerning which CF cards can be used, please contact your local T&D dealer or 
representative. 
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Outline of Use 
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 1. Check the following items before using WS-2

- PC Operation  - Weather Station Operation
- Computer and Network Setup  - Adobe Flash Player (Version 7 or higher)

 2.  Getting the WS-2 Ready to Use

- Connect the AC adaptor and LAN cable  
- Check the signal input method and Connect the signal wire

 3.  Connecting to the Network / Internet 

- Connect the WS-2 to a HUB or to your computer (Even if you are planning to use a wireless 
LAN, it is necessary to make the initial settings via a wired connection) 

 4.  Installing the WS-2 for Windows 
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 5.  Initialization Settings

- Search of WS-2    - Enter the "IP Address" and "Subnet Mask".

 6.  Detailed Network Settings

- Receive the Settings  
- Make and Change Settings (WS-2 IP address, subnet mask, gateway address, Login ID and 

Password, DNS server, Wireless LAN, SMTP mail server, POP before SMTP, IP Block, Time 
Difference and Port Number settings)

 7.  Rebooting the WS-2 (Restarting the System)

 8.  History Function / Communication Time Settings 
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 9.  Before opening Weather Display Live

- Download and install Adobe Flash Player (Version 7 or higher) 
   if you do not already have it installed on your computer
- Make necessary settings to the Weather Station

10. Opening the Weather Display Live

- Live display of weather data measurements such as Barometric Pressure, Humidity,  
Temperature, Wind Speed / Direction and Rainfall    - Shift Unit    - Graph Display

11.  Management of WS-2

- Warning Settings  - Data Transfer Settings  - WS-2 Device Confi guration

12.  Rebooting the WS-2 

M
ulti-scale G

raph

13. Opening Multi-scale Graph

- Zoom In and Out on the Graph   - Data List Display  
- View All / Selected Channels in One Graph
- Graph Maintenance (Edit Recording Conditions, Re-order / Delete / Merge Data by Channel, 

Change Graph Colors and Scale Lines, etc.) 

14. Graph Print Previewing and Printing / Saving Data 
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Checking your Operating Environment

To properly use the logger, the following operational environment is necessary.

PC Operating Environment

OS
Microsoft Windows 2000 / XP / Vista (English)
* To install the Settings Utility, it is necessary to have Administrator Rights for the computer into 

which it will be installed.

PC/CPU
A Stable Windows Operating Environment
LAN, TCP/IP Communication Possible

Memory Capacity Enough memory to stably operate Windows

Disk Space More than 10MB free space(More free space is necessary for data)

Monitor SVGA(higher than 800×600 recommended),   more than 256 colors

LAN 100BASE-TX or 10BASE-T / Twisted pair cable conforming to Category 5 (STP/UTP)

Web Browser
Internet Explorer 6.0 or higher
Fire Fox 2.0 or higher

   [Using a LAN]
Connect the provided LAN cable to the HUB that is connected to your computer. 

   [Connecting Directly to a PC]
Connect the provided LAN cable to the HUB that is connected to your computer. 

* LAN cross cables are not included with the product. Please purchase separately.

   [Using a Wireless LAN]
Please use a Wireless LAN card and a Wireless LAN access point (Combined Wireless LAN and Hub OK). 

* For information and updates concerning which CF cards can be used, please contact your local T&D dealer or 
representative. 

   [Using the Internet]
- In order to connect to the Internet, you must fi rst make arrangements with a provider for a line. 
- In order to send mail via the Internet, user authentication may be required. The WS-2 has been designed to 

enable the use of POP before SMTP. It should, however, be noted that it has not been designed to be com-
patible with other authentication methods such as SMTP authentication. 

- It may also be necessary to get an IP address or domain and make domain name server and other settings. 
- For more details about various settings, it is best, if present, to contact the network administrator. To get more 

details about your Internet connection and setup, please contact your provider. 
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Getting the WS-2 Ready to Use

Connecting the LAN Cable

NOTE:
- When fi rst making settings, please connect to a 

computer that is connected to the local network (same 
broadcast domain). 

-  To avoid poor connections, be sure to push the 
sensor connector securely into the jack.

Connecting the Signal Wire
   [When wishing to use contact output for a warning occurrence]

1. Prepare a 0.5 to  0.9 single type wire and remove the covering to about 10mm 
from the tip.  Prepare a 0.5 to  0.9 single type wire and remove the covering to 
about 10mm from the tip.

2. Using a screwdriver or other such tool, while pressing down on the terminal button 
<B> at the back of the unit, insert the wire into the hole <A>.

Enlarged view of Wire 
Connection Terminal

<A>

<B>

External Output Terminal (buttom)

        

              

ON/OFF Output Signal 
Output via photo MOS relay  
Voltage when OFF: AC/DC less than 50V
Current when ON: less than 0.1A
Resistance when ON: 35

Example of Output Signal Connection
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Connecting a Weather Station to the WS-2

NOTE:
-  To avoid poor connections, be sure to push the 

sensor connector securely into the jack.
- Tighten and fasten both sides with screws.

 For connecting Davis® Vantage PRO2
In order to connect a Davis Vantage  PRO2 to a WS-2, it is necessary to use a Windows compatible ver-
sion of Weather Link for Davis Vantage PRO2 with a Serial Port connection. For details about the Weather 
Link, please contact the shop where you purchased the Davis Vantage PRO2.

 For connecting Texas Weather Instruments® Weather Processing System (WPS series)
Please use the serial communication cable that is included with the product. 

Connecting the AC Adaptor 

NOTE:
- To avoid poor connections, be sure to push the sensor 

connector securely into the jack.
- Do not use an AC adaptor other than the one that is 

supplied with the product. Doing so may cause fi re or 
other trouble.

- Insert the AC adaptor plug into an AC 100V socket. 
Inserting the plug into a socket with different voltage may 
cause fi re or other trouble.

- Do not insert or pull out the AC adaptor plug with wet 
hands or if there are water drops on the plug. This may 
cause electrocution. 
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Using this software with Windows® Vista

Notes about graph operation
- Opening a Multi-scale Graph (.vt7) by dropping it into the Graph window

If you wish to open a fi le by dropping it into a Graph, it will not appear if the Graph has been opened us-
ing [Run as Administrator]. Please open the Graph as a general User.  In general, we suggest when using 
Vista to only use [Run as Administrator] to open the Graphs the fi rst time in order to link the type of data 
fi les (extension) to the Graph programs. After that please open as a general user and carry out the open-
ing of data as usual.

About the Saving Location for Data Files
The application automatically creates a new data fi le each time an Auto-Download session occurs. Note 
that when using the Vista OS the [Virtual Store] function will redirect fi les from the default folder into which 
the program was installed to separate folders under [Program Files] for each user, as shown below: [C:\
User\(AccountName)\AppData\Local\VirtualStore\Program Files\(Application)].

( EX:
If login was carried out using the account name [myname] and [WS-2 for Windows] is the application being 
run, the saving location will appear in the application window as: [C:\Program Files\WS-2 for Windows\
data] but due to the [Virtual Store] function the actual saving location will be [C:\User\myname\AppData\
Local\VirtualStore\Program Files\WS-2 for Windows\data].
If the login was carried out from [Run as Administrator], the fi le will be saved to the folder as it appears in 
the application window.
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Installation

- Is Windows® operating properly?
If Windows is not operating properly, [WS-2 for Windows] may not be installed correctly or it may not oper-
ate properly.

- Please quit all other applications.
If other programs are open, please close and quit all of them, making sure to quit all Quick Start programs 
such as a virus checker.

- For Windows 2000, XP and Vista, in order to install [WS-2 for Windows], it is nec-
essary to have Administrator rights (Computer Administrator) for the computer in 
which you wish to install it. 

NOTE:
- To install WS-2 for Windows, it is necessary to have Administrator rights (Computer Administrator) for the computer 

in which you wish to install it.   

For Windows 98SE / Me / 2000 / XP
1. Start Windows.

2. Place the accompanying CD-ROM into your CD-ROM drive.  In a few seconds, the 
[Start] window will appear.

- If that window does not automatically open, please open it by double clicking the CD-ROM icon in [My Computer] on 
your desktop. 

- Or, if after double clicking the CR-ROM drive, the fi le appears in the CD-ROM folder, double click on the "start.exe" 
icon.

3. Select [Install WS-2 Settings Utility] and click the [Execute] button to start the instal-
lation.

[Execute]
Button

Select

4. Continue the installation by following the directions as they appear.

5. After installation has been completed, WS-2 for Windows will be registered in Win-
dow's [Start] Menu. 
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For Windows Vista
1. Start Windows.

2. Place the CD-ROM in the appropriate drive.
*  If the window automatically appears, under [Install or run program], click on [Run start.exe]. 

For some applications, the above may appear as [Run fi rst.exe] 

Click

3. The  [Start] window will appear. 
* If the [Start] Window does not automatically open, please open it by double clicking on the CD-

ROM icon in [Computer]. 

[Execute]
Button

Select

4. Select [Install WS-2 Settings Utility], then click the [Run] button, the [User Account 
Controls] window should appear. 

5. Click [Next] to start the installation.

* Confi rming the contents as you go, install the software according to the directions.

* After installation is completed, an icon for [WS-2 for Windows] will appear in the Start Menu.
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WS-2 Settings Utility

Opening the WS-2 Settings Utility  
From the list of programs in the Window's Start Menu, click on [WS-2 for Windows] - [WS-2 
Settings Utility].

Main Items in the WS-2 Settings Utility 
  [Network Initialization] Tab

After purchasing a WS-2 unit, the fi rst step is to make all Network Initialization Settings for connecting to a 
network.

  [Detailed Network Settings] Tab 
The reception of WS-2 settings and more detailed network settings can be made here.

NOTE:
- Please open the WS-2 Settings Utility from only one computer at a time in the same network (same broadcast 

domain).
- If you open the WS-2 Settings Utility on multiple computers in the same network, it may not work properly. 

Menu(Bar)
Functions(Tab)
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WS-2 Settings Utility Menu

Using Help
For details about how to use the software, please see the explanations in the Software Help Menu.

-  By clicking on [Help] in the Menu Bar and then [How to Use Network Settings Utility] you can click on one of the tabs 
[Contents] or [Index] to search for the topic or term you are unsure about or have questions about.

[Contents]
By clicking on one of the topics listed, you can 
fi nd detailed information for that subject.

[Index]
By selecting a Keyword in the Keyword list, 
and clicking the [Display] button at the bottom, 
a detailed explanation will appear.

* By clicking the [    ] button in a dialog 
box, an explanation for that dialog box will 
appear.

History Function Settings
If you wish to disable the History Function, in the WS-2 Settings Utility Menu, please select [Login 
History]  [OFF].  Please note that a history will remain viewable from when before it was disabled. 
To erase a history, please click on [Clear Login History] in the Menu. 

   [Login History]
If you wish to disable the History Function, select [Login History]  [OFF].

   [Clear Login History] 
Use this to erase the entire login history.  By clicking [Clear Login History], a confi rmation message will ap-
pear. Select "Yes" to erase the entire login history. 

Communication Time Settings
In the [Detailed Network Settings], communication speed settings can be made. It is possible to 
change the communication time / speed for all type of communication depending on your network 
environment. Select the best setting from the 5 choices 1, 2, 3, 4, 5.  Normally the setting should be 
[1 (fastest)].

NOTE:
- If during communication problems occur such as, 

frequent communication errors or data is only partially 
received, please try setting the Communicatio Time to a 
slower number, such as 2 or 3. 
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WS-2 Network Initialization 

To connect a WS-2 to a network, it is necessary to enter an IP Address and Subnet Mask 
that are appropriate for your network. 

NOTE:
- Please note, that upon purchase, all WS-2 units are set with the same IP address. Do not connect more than one 

unit with the same address to the network at the same time.
- To make IP address changes, connect one WS-2 unit at a time and carry out the changes.
- Also, if the unit connects to an outside network via a router, it will be impossible to carry out initialization settings. 

1. Connect the WS-2 via cable to a network. 

 It is necessary to connect the WS-2 to the same network as the computer running the [WS-2 for 
Windows] application.

2. In [WS-2 Settings Utility], click on the [Network Initialization] Tab and then click on 
the [Search] button. 

 After clicking, the search results will be shown in a few seconds.

[Network Initialization] Tab

Connected WS-2 
Search Results

[Search]
Button

3. From the displayed list, select the WS-2 to which you wish to make settings and 
then either double click on that address or click on the [Change Settings] button to 
open the [Network Settings] window.

[Change Settings]
Button
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4. Enter an IP Address and Subnet Mask. 

NOTE:
- Enter an IP address and subnet mask that is appropriate for your network.
- Do not use the same IP address for two different units.It may cause abnormalities to the entire network system. 

Enter the "IP 
address" and 
"Subnet mask"

[Send ] button

Enter the "Login 
ID"and"Password"

5. Enter the "Login ID" and "Password".

 WS-2 Factory Default Settings… Login ID: "wsc-user" /  Password: "wsc-passwd" 

 You cannot make any necessary changes to the login ID and password here.  Make changes to 
these from [Detailed Network Settings]. (See page 27 for details) 

6. After checking for entry errors, click the [Send] button. After transmission has been 
completed a message will appear.

7. Click the [OK] button to fi nish. 

 After settings are completed the WS-2 will automatically restart.  During the restarting process, a 
search cannot be performed, even if you click the [Search] button.  Please try again after one 
minute.

 

If no units are detected

- Check the connection between the computer and the WS-2. 

- Check the hub power switch and the network cable type. 

- If some network environments, it may be necessary to make changes to the IP address and subnet mask via 
computer in order to carry out a search.  For details, see page 45  [Checking and Making Changes to Computer 
Network Settings]. 

- Check if your wireless LAN card has been formatted. Do not use an unformatted wireless LAN card. 

- If security software used to detect viruses is currently activated, a successful search may not be carried out. Please 
temporarily close the software.
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Detailed Network Settings

The reception of WS-2 settings and more detailed network settings can be made here.

 To make these settings it is necessary to have fi rst made proper settings with a correct IP address. 

Receiving the Settings
1. Click the [Detailed Network Settings] Tab.

2. In the [Receive Settings] Area (see *1 below), enter the information for the WS-2 
you wish to make settings for and click the [Get Settings] button.  The current set-
tings will appear.

- A list that shows all of the IP addresses and domain names with which successful communication 
has occurred until now can be viewed in the [Settings History] pull down menu.

 If you select an IP address or domain name here, the Login ID, Password and Port Number will be 
entered automatically. 

 Note that if you have turned [OFF] the [Login History] in the [Menu] or if you have deleted the Login 
history by having clicked [Clear Login History] the Settings History will not appear.

 By clicking the [Settings History] button you can receive the current settings.

 Communication is impossible via a proxy server.

Current 
Settings as 
Received

[Get Settings]
Button

[Change Settings]
Button

*1: [Receive Settings] Area
Enter info for the WS-2 you wish to make 
settings in

[Detailed Network Settings] Tab

History

Settings 
History
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Detailed Network Settings
1. In the [Detailed Network Settings] tab page (see the previous page), click the 

[Change Settings] button at the bottom right to open the "Detailed Network Settings 
Window and make any necessary changes. 

- For details about setting each item, See page 29.

"Recipient WS-2" Settings Area
Enter info for the WS-2 you wish to make settings in.

[WS-2 Restart] Button

[Send Settings] 
Button

2. Enter the info for the recipient of the settings and click the [Send Settings] button to 
have the settings sent to the Recipient WS-2.

3. Once the settings have been successfully transmitted, a message will appear ask-
ing you if it is OK to restart the system.

NOTE:
- The new settings will not become 

valid until the WS-2 is restarted.

4. After restarting has fi nished, the settings will have been completed.

  [WS-2 Restart] Button
If the browser does not open, or if any errors occur during communication, click the [WS-2 Restart] button.

NOTE:
- Note that by clicking the [Send Settings] button over and over, communication may become impossible. Please try 

again after one minute.
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In the [Detailed Network Settings] window, you can make the following settings. In the [Detailed 
Network Settings] window, you can make the following settings.

  [IP Address / Subnet Mask]
Enter the WS-2 IP address and subnet mask.

  [Gateway Address]
Enter the WS-2 gateway address. 

  [Login ID / Login Password]
Enter the WS-2 Login ID and Password. The Login ID / Password entered here will be necessary for log-
ging into the WS-2 Administration Menu on the Web. (See page 36 for details.) 

NOTE: 
- We strongly suggest that you make changes to the factory default Login ID and Password.  For security reasons, 

continued use of the default values is not recommended.
- The User ID and Password can be made up of up to 15 characters using alphabet, numbers, "-" (hyphens) and 

"_"(underscores).  
- Note that spaces and <> cannot be entered. If you wish to use these symbols, please make any necessary chang-

es to the ESS-ID and WEP Key Code. 

  [DNS Settings]
If it is necessary to assign a domain name, enter a DNS server.

  [Wireless LAN Settings]
If you are using a Wireless LAN to access the WS-2, then make settings for the following items.

Wireless LAN ESS-ID ------- If you leave this fi eld blank, the setting will be to allow for connection to any available 
network.

WEP Key Type ------- Select character string or hexadecimal. 

WEP key code ------- Character string :  The number of characters in key code will be 0, 5, 13.

Hexadecimal :       The number of characters in key code will be 0, 10, 26.

NOTE: 
- Leave this box empty if WEP-KEY is not used.
- Note that spaces and  < > cannot be entered. If you wish to use these symbols, please make any necessary 

changes to the ESS-ID and WEP Key Code. 

  [Port Number]
Changes can be made to the FTP Server Port Number (FTP / DTP) to which the WS-2 will be connected 
and to the user HTTP Server Port Number to match your LAN environment.

  [Mail Settings]
Enter the server (SMTP server name) from which you wish to send E-mails.

  [POP Before SMTP]
When having warning report mails sent and using an SMTP server that requires POP before SMTP au-
thentication, it is necessary to make these settings.
POP Server Name, POP User ID, POP Password,  POP Port Number (Normal 110)

 - Note that spaces and < > cannot be entered. 

 [Time Difference]
Set the time difference from Greenwich Mean Time (GMT).
If this is not set correctly, the Clock settings from SNTP will not be correct.

 [IP Block]
This will forbid access to the WS-2 except from the specifi ed IP address.   If you do not enter the IP ad-
dress of the computer from which you are making settings, after the WS-2 restarts, access will not be 
permitted from that computer. 
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Returning Settings to Factory Default 

By pressing the  <RESET>  button, the WS-2 unit will be initialized and returned to the 
Factory Default Settings. 

1. Press in the <RESET> button on the side of the WS-2 unit with a pointed object for 
more than three seconds.

<RESET> Button

2. When the <POWER> lamp on the face of the WS-2 unit disappears from the dis-
play,  release the <RESET> button and the unit will have been returned to the fac-
tory default settings.

 In order to activate the settings, the unit will automatically reboot. 
    

NOTE:
- Rebooting may take about two minutes to complete. 
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Weather Display Live

What is Weather Display Live?
"Weather Display Live"  allows users to monitor real time measurements of weather data when con-
nected to a weather station, delivering clear, graphical presentations. 

  [Weather Stations]
- Vantage PRO2™ can be purchased from Davis Instruments Corp.
- Weather Processing System (WPS series)® can be purchased from Texas Weather Instruments Inc. 

* To view "Weather Display Live" in your browser, it is necessary to have Adobe Flash Player (Version 7 or higher) 
installed on your computer.

Before opening Weather Display Live
-  The WS-2 has been designed to be used with a weather station. Please make any necessary 

settings to the weather station you will be using with the WS-2 as outlined in the guide that 
comes with the product.

-  Make sure that all monitoring condition settings, such as date and time or recording interval, 
have been made.   Also note that the WS-2 supports only the following baud rates:

-  9600bps , 19200bps
 If the baud rate setting for the Weather Station has been made to one other than listed above, 

please change to one of the above before connecting the WS-2 (Recommended baud rate: 
19200bps).

-  The WS-2 is designed to display graphs using gathered recorded data from weather stations. 
The WS-2 itself does not have any recording function. Therefore, if you wish to view a graph 
with one month of data saved in a weather station, the weather data recording interval setting 
must be set to 30 minutes or longer.  If the recording interval setting is less than 30 minutes, it 
will be impossible to save one month of data in a weather station. Hence, with WS-2 the graph 
can only show less than one month of data (recorded data only). Note that even if the recording 
interval has been set at 30 minutes or longer, depending on the amount of elapsed time from 
the starting of monitoring, it may be impossible to display all recorded data in graph form. 

 (For details about recording interval settings, refer to the guide that came with the weather sta-
tion being used with the WS-2.) 

-  Make sure to go to "WS-2 Settings Utility" and make the proper IP address and subnet mask 
settings. After having made the appropriate settings, turn off the power and connect the weath-
er station to the WS-2. Then, turn the power on again.
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Opening the Weather Display Live
1. Open Internet Explorer.

- If you wish to use the Internet, make sure that the power for the router and computer are on so as to 
enable connection to the Internet.

- Set the browser so as to enable Cookies.

- Make settings to enable both Java applets and Java script.

2. In the address section, enter the WS-2 IP address you wish to view, and press the 
[Enter] key.  A confi rmation window will appear showing the connection between the 
WS-2 and the weather station.

Enter 
address

3. After the connection has been confi rmed, the window will automatically change to 
view Weather Display Live.

If you are using Davis Vantage  PRO2 If you are using Texas Weather 
Instruments WPS series 

Weather Display Live

   If the Weather Display Live does not appear....

- Make sure that the address you entered is correct. 

- Check to make sure that the IP address and subnet mask are set correctly and if necessary redo the [Detailed 
Network Settings]. 
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About Weather Display Live window
[Davis Vantage PRO2]

2

3

4

5

6 7 8

11

12

1

109

 Station Name
Displays the device name you assigned.  For details about assigning device name,  see page 42.  
 Barometer
Displays the current barometric pressure.
 Humidity
Displays the humidity received from the outdoor sensor.
Indoor Humidity 
Displays the humidity received from the outdoor sensor. 
Indoor Temp
Displays the humidity at the location where the Weather Station is placed. 
Wind Direction 
Displays the current wind direction. The red mark shows the dominant wind direction for the past 60 min-
utes. 
Wind Speed
Displays the current wind speed. The average value for the last ten minutes. The red mark shows the fast-
est speed so far that day. 
Gust 
Displays the instantaneous wind speed. The red mark shows the fastest gust speed so far for that day  
Rainfall
Displays the Annual, Monthly, and Daily rainfall.
Windchill 
Displays the windchill factor taking into account the effect of wind speed on temperature.
(Red Mark: Highest / Blue Mark: Lowest) 
Temp 
Displays the temperature received from the outdoor sensor.  (Red Mark: Highest / Blue Mark: Lowest) 
Function Buttons

[Pressure] Shifts the Barometric Pressure unit (mb, hPa, and inHg) used in the display 

[Wind] Shifts the Window Speed and Gust unit (kts, m/s, Kph, and mph) used in the display 

[Rainfall] Shifts the Rainfall unit (mm, inches) used in the display

[Temp] Shifts the unit for the display of Temp, Windchill, and Indoor Temp display between  and 

[Graph] Various recorded data is displayed in graph form
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[ Texas Weather Instruments WPS series ]

2 3

1

4 5 6 7 8

9

10

11

12

 Station Name
Displays the assigned device name. For details about assigning device names, see page 42.  
Wind Direction 
Displays the current wind direction. The red mark shows the dominant wind direction for the past 60 min-
utes. 
Wind Speed
Displays the current wind speed. The average value for the last ten minutes. The red mark shows the fast-
est speed so far that day. 
 Barometer
Displays the current barometric pressure.
Dew point 
Displays the dew point: temperature at which the air cannot hold any more water, so that dew forms on 
surfaces outdoors. (Red Mark: Highest / Blue Mark: Lowest) 
Heat index 
Displays the perceived temperature sensed under the infl uence of humidity on temperature.
(Red Mark: Highest / Blue Mark: Lowest) 
 Windchill 
Displays the windchill factor taking into account the effect of wind speed on temperature.

 
Temp 
Displays the temperature received from the outdoor sensor.  (Red Mark: Highest / Blue Mark: Lowest) 
Rainfall
Displays the Monthly, and Daily rainfall. 
 Humidity
Displays the humidity received from the outdoor sensor.
Indoor Temp
Displays the humidity at the location where the Weather Station is placed. 
Function Buttons

[Pressure] Shifts the Barometric Pressure unit (mb, hPa, and inHg) used in the display 

[Wind] Shifts the Window Speed and Gust unit (kts, m/s, Kph, and mph) used in the display 

[Rainfall] Shifts the Rainfall unit (mm, inches) used in the display

[Temp] Shifts the unit for the display of Temp, Windchill, and Indoor Temp display between  and 
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Graph Display (Vantage PRO2)
Note that this function is available only for those using the Vantage PRO2. 
By clicking the [Graph] button from among the function buttons (see previous page 33), 
various graphs can be viewed.

X

Click here to close 
the graph

View Menu

Scroll up and down

Barometric Pressure, Rainfall, Windchill, Wind Direction, Wind Speed and Temperature data can be 
viewed in graph form according to the conditions below. 
Drag the scroll bar up and down to the desired menu.

    - Last 24 hours 30 hours' (20 points') worth of data can be shown in one graph at an interval of 90 minutes

    - Last 30 days   30 days' worth of data can be shown in one graph.

    - Last Hour          The last one hour's worth of data can be shown in one graph

    - Live        The current measurements are shown in a real time progressive graph 

- The WS-2 is designed to display graphs using gathered recorded data from weather stations. But, in some instances 
due to the recording interval settings or data details, all data readings may not be displayed. 

- When using "Last Hour", the last one hour's worth of data will be stored in the WS-2. In order to view the entire 
record in Graph form, make sure that at least one hour has elapsed from the start before viewing. 
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Management of WS-2

Administration Menu
In order to make settings such as for warnings and the transferring of data, it is necessary to ac-
cess the Administration Menu via your Internet browser. 
Please open Internet Explorer and enter the Administration Menu address   (such as: "http//*********/
admin.htm") directly in your browser's URL bar; this will take you to the Administration Menu Login 
window. (********* is the WS-2 address that you have set.)
Ex)  http://www.prodigio.jp/admin.htm

It is necessary to login in order to operate the 
Administration Menu. Enter the Login ID and 
Password that you set in the WS-2 Settings 
Utility.
    WS-2 Factory Default Settings
    Login ID: "wsc-user" 
    Password: "wsc-passwd"

Login Window

By logging in, the Administration Menu window will appear. From the menu buttons on the left, you 
can open each "Settings" window. 

Administration Menu Top Window

Administration 
Menu Buttons

NOTE:
- When operations are not performed for ten minutes or longer, the user will automatically be logged out.

To the "Weather Display Live" Window  
By clicking on the WS-2 logo at the upper right it 
is possible to jump to the "Weather Display Live" 
window. 
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Warning Settings: [Properties] Button
By making upper and lower limit settings for the WS-2, when one of the set upper or lower limits 
has been exceeded, a warning report mail can be sent via e-mail to specifi ed e-mail addresses 
and/or the External Output will be switched ON. It is possible to simultaneously see or hear a warn-
ing notifi cation on site by connecting to an external device, such as alarm or light. 
(For details about External Output Terminals, see page 18 for details.) 
After confi rming that all entries are correct, click the [Save Settings] button. Then open the next 
menu.

[Save Settings] Button

[Properties]
Button

Warning Settings 
    [Use Warning : Enable / Disable] 

 If you wish to make use of the warning function, place a check next to [Enable]. 

    [Type of External Output : Pulse (1 sec) / During Warning] 
 Select the "Type of Extrenal Output": how the external output will be switched ON.  When the External Output is 
switched ON, the OUTPUT (LED) lamp will light up. 

- Pusle (1 sec)  
 Regardless of the length of time a measurement has exceeded a set upper of lower limit the External Output will 
stay ON for one second. 

- During Warning 
  This will keep the External Output at ON during the time when a measurement is exceeding a set upper of lower 
limit. 

Warning Items Settings
    [Upper Limit / Lower Limit] 

 Please enter the upper and lower limit values (only upper limit for Wind Speed and Rainfall). 

    [E-Mail] 
 By placing a check in the checkbox, if a warning occurs, a warning report e-mail will be automatically sent. Please 
make settings for "Mail Recipient Addresses" (E-Mail Headers). 

    [OUTPUT] 
 By placing a check in the checkbox, if a warning occurs, the External Output will be turned ON. Also, check the above 
"Type of External Output". 

    [Current]
 When a warning occurs, the icon  [ ]  will appear.
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E-Mail Headers (Warning Report Mail Recipient Address Settings)  
     [To / From / Subject] 

 If you have checked "E-Mail" in the [Warning Items] area, make warning report mail recipient address settings here.  
The measurement and conditions for the warning occurrence at the time of warning will automatically be written into 
the body of the mail.

NOTE:
- Warning monitoring is carried out at one minute intervals, therefore, it may take up to one minute after a waring 

condition occurrencehe before the starting of an e-mail transmission or the turning ON of the external output.

Data Transfer via FTP: [FTP] Button 
Make settings here for Data Transfer via FTP. 
After confi rming that all entries are correct, click the [Save Settings] button. Then open the next 
menu. 

[Save Settings] Button

[FTP]
Button

FTP Settings
     [Upload via FTP: Enable / Disable]

 If you wish to enable the FTP data transfer function, place a check next to [Enable]. 

     [FTP Server Name]
 Enter the FTP server name you wish to upload to. 

     [Upload Path Name]
- Basic Path Name   

 Enter the Upload Pass Name. If you are adding a number please enter a [ * ]  mark.  

- Add Number 
 None --------------------  Uses a fi xed fi le name and will always be overwritten.   

 Sequential Number --  Replaces the asterisks (**) with sequential numbers ranging from 0000 to 9999

        (Return to 0000 after 9999).

 Date ---------------------  Adds the date and time to the basic path name.  
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     [Type of Data]
- Original

 The original unchanged data type as it was received via DMPAFT command.

- VT7 Format
 The data format which can be handled by Multi-scale Graph.  (For details about data fromats, see page 41)

     [User ID]
 Enter the Login ID for the FTP server. 

     [Password]
 Enter the Password for the FTP server. 

[FTP Data Transfer Interval : 10 min. / 30 min. / 1 hour / 2 hours / 12 hours / 1 day]
 Select the Upload Interval. The time settings for uploading are set as follows: 

 10 min.--------  Every 05 / 15 / 25 / 35 / 45 / 55 minutes after each hour 

 30 min.-------- Every 05 and 35 minutes after each hour 

   1 hour-------- Every hour, 05 minutes after the hour 

   2 hours------- Every even numbered hour, 05 minutes after the hour 

 12 hours------- Every day at 00:05 and 12:05 

   1 day --------- Every day at 00:05 

* Due to internal processes, the date and time of data transfer may be about fi ve minutes late. 

Anything Weather.com Settings 
If you wish to have recorded data uploaded to Anything Weather.com, place a check next to [Enable] and 
enter the FTP Server name, Upload Path, User ID, Password, and Interval as above. 
Enter the FTP Server Name you wish to upload to. 
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 Data Transfer via E-Mail: [E-Mail] Button  
Make settings here for Data Transfer via E-Mail. 
The temperature / humidity / pressure / rainfall / wind speed / direction at the time of sending an 
e-mail will automatically be written into the body of the mail. 
After confi rming that all entries are correct, click the [Save Settings] button. Then open the next 
menu.

[Save Settings] Button

[E-Mail]
Button

E-Mai Settings
    [Sending E-Mail: Enable / Disable]

 If you wish to enable the E-Mail data sending function, place a check next the [Enable]. 

    [E-Mail Data Sending Interval]
 Select the Upload Interval. The time settings for uploading are set as follows: 

 10 min. -------- Every 01 / 11 / 21 / 31 / 41 / 51 minutes after each hour 
 30 min. -------- Every 01 and 31 minutes after each hour 
   1 hour -------- Every hour, 01 minute after the hour 
   2 hours ------ Every even numbered hour, 01 minutes after the hour 
 12 hours ------ Every day at 00:01 and 12:01 
    1 day -------- Every day at 00:01 

 *Due to internal processes, the date and time of data transfer may be about fi ve minutes late. 

    [Attached Logged File: None / Original Format / VT7 Format]
- None 

 Will not attach any logged data. 

- Original Format 
 Attaches the original unchanged data type as it was received via DMPAFT command. 

- VT7 Format
 This will attach the data in a format which can be opened by Multi-scale Graph. 

 *For details about data fromats, see the next page. 

E-Mail Headers
    [To / From / Subject]

 Enter the recipient address / sender address / subject for the E-mail.
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 About data formats of attached data Original
  [Original]

If you select [Original], data formats vary depending upon your Weather Station type. 
 
   * If you are using Davis Vantage PRO2 ™ 

 A bundle of 52 byte-sized data blocks received by the DMPAFT command is stored sequentially with the oldest data 
at the head. For details about "One block (52 bytes)",  please refer to the User"s Manual for "Vantage Serial Protocol 
Docs Ver.2.0 or above" from Davis Instruments. 

52 bytes 52 bytes 52 bytes 52 bytes

   * If you are using Texas Weather Instruments® WPS series 
 Data received by the "r", "k", "e", "W" commands is stored as text fi le data. 
 Examples of Files  ----- "r" command 
    "k" command 
    "e" command 
    "W"   command 

            "r" command     "k" command     "e" command     "W" command

10:54 06/07/07 SE  00MPH 001K 460F 460F 000% 16.05F 00.00"D 00.00"M 00.00"T

-460DP-460TH-460WC

SS 06/07 10:54   001  06/07 10:54   001 K
TI 06/07 10:54   460  06/07 10:54   460 F
TO 06/07 10:54   460  06/07 10:54   460 F
RH 06/07 10:54   000  06/07 10:54   000 %
BP 06/07 10:54 16.05  06/07 10:54 16.05 "
RR 00/00 00:00 00.00  06/07 00:00 00.00 "
WS 06/07 10:54    00  06/07 10:54    00 MPH
WD               SE                 SE

10:54
0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135
0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135
0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135
0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135
0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135
0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135   0 135

- For details about each command, please refer to the "TWI Command Documentation" on the Texas Weather 
Instruments website.

  [VT7 ]
The data format which can be handled by the accompanying software "Multi-scale Graph".  It is possible to 
view the data in graph form for Temperature / Humidity (Outside and Inside), Barometric Pressure, Wind 
Speed and Rainfall. 
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 WS-2 Device Confi guration: [Properties] Button
Here you can make communication settings for the WS-2. 
After confi rming that all entries are correct, click the [Save Settings] button. Then open the next 
menu. For the settings take effect, it is necessary to reboot the WS-2. 

[Reboot]
Button

[Save Settings] 
Button

[Properties]
Button

Weather Station Type
    [Station : TWI WPS Series / Davis Vantage PRO]

 Please select one of the Weather Station types.

Weather Display Live
    [Station Name]

 It is possible to display the device name you assigned at the top left "Weather Display Live" window. 

    [Refresh Interval: from 5 to 60 seconds]
 Here you can make the display refresh interval setting for the "Weather Display Live". Specify the desired refresh 
interval from 5 to 60 seconds. 

Communication Port
    [Baud Rate: 9600bps / 19200bps ]

 Please select one of the baud rates for the WS-2 COM Port. Please set to the same baud rate setting as that made 
for the Weather Station. 
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 System:  [Information] Button 
Pressing this button will display the current settings for the WS-2. 

[Information] Button

[Logout] Button

    [Check the following settings]
Network Settings ----  Basic network setting information

E-Mail Settings -------  Necessary information for sending E-mail

Wireless LAN ---------   Information on Wireless LAN 

Port Numbers ---------  The HTTP Server Port Number, the FTP Server Port Number you wish to upload to, and others. 

Communication Port -  Baud rate (communication speed) for Communication Port 

System Information --  WS-2 Version Information 

 System:  [Reboot] Button
Upon clicking the button a confi rmation message will appear. Click the [OK] button to reboot the 
WS-2.  After reboot has fi nished, you will return to the Administration Menu Login window. 

 System:  [Logout] Button 
This will allow you to exit "Administration Menu" and return to the Administration Menu Login win-
dow. Click this button to fi nish operations on the Administration Menu. If any of the operations on 
the Administration Menu are performed, it is absolutely necessary to logout. 

Note:
- When operations are not performed for ten minutes or longer, the user will automatically be logged out. 
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Viewing Current Readings via Mobile Phone

It is possible to view the current readings via your mobile phone by accessing the URL for 
the Weather Display Live.

NOTE: 
- The example fi gure below is only an image of browser display. The display layout is different from that on actual 

windows. 
- Depending on the type of mobile phone, current readings may not be viewable.
- To view the current readings monitor via mobile phone, it is necessary to open the WS-2 to the public on the Inter-

net.
- The weather data measurements shown in the browser are those of when accessing the "Weather Display Live". 

1. Open the URL entry display and enter the URL for the WS-2 logger you wish to 
view and press enter.  

2. Weather data measurements are displayed. The current readings will not be auto-
matically refreshed. Press the [Reload] button to refresh data. 

Display Contents 
The following data when accessed via a browser: Temperature / 
Humidity / Barometric Pressure / Rainfall / Wind Speed / Wind 
Direction 
Date and Time when data was collected. 

Ex. of a display
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Checking and Making Changes to Computer Net-
work Settings

In some network environments, it may be necessary to make changes to the IP address 
and subnet mask at the computer side in order to carry out a search.  See the following 
procedures for checking and making changes to your computer network settings.

1. In the Windows [Control Panel], open [Network Connections].

2. Select the Network adaptor that you are using, and right click with the mouse and 
open the "Properties".

3. Under the [General] Tab, in [This conection uses the following items:] select "Inter-
net Protocol (TCP / IP)" and click on [Properties] button.    

Select
 "Internet Protocol 
(TCP / IP)"

[General] Tab

 [Properties] 
Button

4. In the [Internet Protocol (TCP / IP) Properties] window, under [Use the following IP 
address:] make sure that the IP address and Subnet mask are correct.
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Confi rm the 
IP address

[OK] Button

Confi rm the 
DNS server

5. In order to return the settings back to the original ones make sure to write down 
the current settings for "IP address", "Subnet mask", "Default gateway", "Pareferred 
DNS server" and "Alternate DNS server".

6. Enter "192.168.1.1" as the IP Address and "255.255.255.0" as the Subnet Mask.

7. After entering, click the [OK] button.

8. Clicking the [OK] button in the "Network Connections" [Properties] window as seen 
in step 3. above will close the window.

9. Once again, in the [WS-2 Settings Utility] run a search and check whether the IP 
address for the WS-2 connected to the network is displayed.

10. If it is displayed properly, make the initial network settings.

11. After making the initial network settings, follow steps 1. - 4. above to open the [In-
ternet Protocol (TCP / IP) Properties] window. Re-enter the "IP address", "Subnet 
mask", "Default Gateway", "Preferred DNS server", and "Alternate DNS server" that 
you had written down before and click the [OK] button.

12. Open the browser, enter the address (URL) that you set in the settings utility and 
check to make sure that the display is proper or not.

- If you are using a company network or are working in an environment that may have special settings and after 
having followed the above procedures still cannot view the display properly, please connect your network 
administrator.



47Multi-scale Graph

Multi-scale Graph

By selecting fi le type "VT7 Format" for transfeirring data (sending e-mails or uploading to 
FTP server), the "Multi-scale Graph" enables you to view all data recorded in the Weather 
Station: temperature / humidity (outside and inside), barometric pressure, wind speed and 
rainfall in the same graph. 
"Multi-scale Graph" is designed to allow you to simultaneously view the display of graph 
channels with different scales. With "Multi-scale Graph",  it is easy to see visually in colorful 
graphical form the changes in temperature and humidity. Moreover, functions such as cre-
ating text fi les and printing data help in the analyzation of gathered recorded data. 
The graphs shown in the "Weather Display Live" display are simplifi ed ones. Please use 
the "Multi-scale Graph" for more detailed data analysis. 

Opening Multi-scale Graph
From the list of [Programs] in the Window's Start Menu, click on [WS-2 for Windows] - [Multi-scale 
Graph]. 
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Main Window Names and Functions

Graph Area
 The area in which the Graph is displayed. The horizontal axis shows time and the vertical axis shows measurement 
data in units as calculated by the selected conversion equation. 

A / B Cursor Movement Buttons and A / B Cursor Buttons 
 By clicking the arrow buttons at the left and right of the bar, you can simultaneously move the A/B cursors. Click and 
drag the A or B button on the bar to move the cursor to the left or right.

A and B Cursor Position Information
 The approximate date and time for the A and B cursor positions and the time difference between the A cursor and the 
B cursor is displayed.

Channel Info Display
The detailed data info for each channel 1 to 7 is displayed below the Graph Display.

ch1. Outside Temperature Name Channel Data Name High. Highest Reading in Calculation Range

ch2. Outside Humidity Interval Recording Interval Low. Lowest Reading in Calculation Range

ch3. Inside Temperature Sample Number of data Avg. Average Reading in Calculation Range

ch4. Inside Humidity CursorA Cursor A position data Sum. Total of Readings in Calculation Range
ch5. Barometric Pressure CursorB Cursor B position data
ch6. Wind Speed Unit Unit
ch7. Rainfall

Vertical Axis Display ON/OFF
 Shift the vertical axis scale display ON/OFF. 

Vertical Axis of Each Channel( )
 The vertical axis scale can be displayed for each channel into which data has been read. By clicking the arrow at the 
corners of the gauge bar [ ] you can scroll up or down on the current display while maintaining the present zoom. 

Menu Bar
 Menus are lined up which contain various commands. They are used to view data or to make settings for the various 
functions in each menu.

Toolbar (Icons)
 Buttons appear for frequently used commands.

Horizontal Gauge Bar and Button for Moving Horizontal Axis
 The time axis moves by clicking these arrow buttons [ ] at the left and right of the bar.  By dragging the gauge you 
can move left and right to the data you want to be displayed.

Vertical Gauge Bar and Button for Moving Vertical Axis
 The vertical axis moves up or down by clicking these arrow buttons [ ] at the upper and lower sides of the bar. By 
dragging the gauge you can move up and down to the data you want to be displayed.

[Calculation Range] Button 
 The [Set High, Low, Avg. Calculation Range] window will appear. (See page 52 for details.) 
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Zooming In and Out on the Graph
  Zooming In and Out on the Graph with Mouse

With the left button drag the mouse to outline the area you want to zoom in on. 
By right clicking on the graph, the Menu will be displayed. With [Return to Original Size] or [Step-by Step 
Return to Original] you can return both the vertical and horizontal axis back to show the entire graph. 

Zoom In 
With the left button drag the mouse to 
outline the area you want to zoom in 
on. 

Zoom Out 
With the mouse, right click on the graph and 
select [Return to Original Size] in the pop-up 
Menu that appears. 

  Use the [Graph] Menu to Zoom Out
The same operation can be done via commands in the [Graph] Menu or by clicking icons in the Toolbar. 

[Graph] Menu Icons in the Toolbar
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Data List Display: from the [View] Menu
Shows all recorded data displayed in the graph as a list. Click [Data List Display] in the [View] Menu. You 
can view all the recorded data including its time and date as a list. 

              [View] Menu

[Date/Time]
Button

Elapsed Time 
Display

Recorded Date/
Time Display  

  [Date / Time] Button
By clicking this button, you can shift the display between the recorded date and the amount of elapsed 
time since recording started.

  [Color Coded Display]
GREEN Dates and times which fall within the calculation range for determining high, low and average 

measurements 
BLACK Dates and times outside the calculation range for determining high, low and average measurement

RED Highest Value

BLUE Lowest Value

PINK Average Value

  [Move to Highest Value / Move to Lowest Value]
By right clicking on a channel data in the Data List Display, a Menu will appear. Click [Move to Highest 
Value] or [Move to Lowest Value] to move to the Highest or Lowest values. By dragging the Scroll Bar up 
and down you can view the corresponding part of the displayed data in the list.

Scroll Bar
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Selected Channels ON / OFF: From the [View] Menu 
Hide or view the data graph for selected channel(s). 
By moving the mouse to [Selected Channels ON/OFF], the channel numbers are displayed. Those 
channels with a check mark next to the number will be displayed in the Graph. If you wish to only 
hide the data graph for that channel, remove the check. 

Checkmark for hiding or viewing the 
data graph for selected channel(s)

[View] Menu

- The same operation can be done by clicking on the [Channel Number] icons in the Toolbar. Click the channel No. of 
the channel you wish to view.

The data for the channel numbers which 
have been clicked will be displayed in the 
Graph. 
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Setting High, Low, Average Calculation Range Command: 
   From the [Tools] Menu
Set the calculation range for determining high, low and average measurements. If no setting is 
made the values within the entire graph will be used as the calculation range. Select [Set High, 
Low, Average Calculation Range] in the [Tools] Menu to make the necessary settings. 

1. Select [Set High, Low, Average Calculation Range] in the [Tools] Menu to open the 
settings window.

2. In the [Set New High, Low, Avg. Calculation Range] box the dates and times that 
appear are those of the AB Cursors when the dialog box is opened.

3. Change the range by entering the desired dates and times and click [OK]. From that 
point the High, Low and Average readings will be calculated within that range.The 
graph display will also show only that data within the calculation range.

[OK] Button

[Entire Graph]
Button

Enter the dates and times 
for the start and end of 
the calculation range. 

  [Entire Graph] Button
By clicking the "Entire Graph" button, the dates and times in the [New High, Low, Avg. Calculation Range] 
box will display those of the entire graph.
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Editing Recording Conditions: From the [Tools] Menu
Change channel names and/or adjust recording start times. Select [Edit Recording Conditions] in 
the [Tools] Menu to open the editing window. 

Put a check on the 
channel number 
you wish to edit. 

Edit Items

[OK] Button

[Restore]
Button

1. By clicking the [Channel. No.] button of the channel you wish to edit, the [Name] 
and [Started Date / Time] in the "Edit Items" display will show info for that channel 
number. 

2. Enter the [Name] and [Starting Date / Time] in the "Edit Items" and click the [OK] 
button. 

  - Up to 32 letters can be entered.

3. If you wish to continue to change other channels, repeat the process as in 1 and 2.

  [Restore] Button
By clicking this button, the settings will return to those when the dialog box was opened.
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Re-ordering Channel Data: From the [Tools] Menu  
You can change the order of the data in channels as viewed in the graph. Select [Re-order Channel 
Data] in the [Tools] Menu to open the settings window. 

1. There are two methods to use when re-ordering channels: [Re-order by Dragging 
the Channel Number] and [Re-order by Selecting the Channel Number]. 

Re-order by Dragging the Channel Number
Ex: If you wish to move Ch.3 to Ch.7 position

Drag the channel number you wish to 
move (Ch 3) to the newly desired channel 
number position (Ch 7) and drop it.

Enter the channels you wish to re-order: 
"Select 1"  Ch. 3, "Select 2"  Ch. 7; 
then click the [Change 1 and 2] button to 
complete the re-ordering. 

Re-order by Selecting the Channel Number 
Ex: If you wish to change Ch.3 to Ch.7 position

[OK] Button

[OK] Button

[Change 1 and 2] 
Button

2. By clicking the [OK] button, the channels will be re-ordered and the graph will be re-
drawn.
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Erasing Selected Channel Data: From the [Tools] Menu
You can erase the selected channel data from graph. Select [Erase Selected Channel Data] in the 
[Tools] Menu to open the settings window. 

1. Put a check on the channel number you wish to erase. 

Put a check on 
the channel 
number you 
wish to erase. 

[OK] Button

2. By clicking on the [OK] button, the selcted data will be erased and the graph will be 
re-drawn. 

Merging Channel Data: From [Tools] Menu 
Use this function when you wish to merge one channel of data with another channel of data. In the 
[Tools] Menu, select [Merge Channel Data] to open the settings window.

Click the [ ] buttons to select 
the channels you wish to 
merge. 

[Merge] 
Button

1. Please make sure to select a channel with older data for the left side. Upon select-
ing the channel for the left, the channels, which are capable of being merged, will 
appear in a list on the right. 

2. Click the [Merge] button to merge two channels of data into one channel. 

NOTE:
- The channel data selected for the box on the right will not be deleted. If you wish to delete, go to [Erase Selected 

Channel Data] in the [Tools] menu to delete that data. 
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Setting Vertical Axis Display Range: From [Tools] Menu 
Set the Vertical Axis Scale Range to Auto or Fixed for each channel. Make settings to have the 
Vertical Axis Scale Range automatically assigned according to type of data or have it remain fi xed 
at the same values every time it is opened. In the [Tools] Menu, select [Vertical Axis Range Display 
Settings] to open the settings window. 

Select [Fixed] and enter 
numerical values.

[OK] ButtonMake all Settings same as Ch. 1 
 

1. Put a check next to [Fixed] for the channel(s) you wish to make settings for and en-
ter the top and bottom values. 

2. If you wish to use fi xed values for all channels, choose fi xed values for Ch.1 and put 
a check next to [Make all settings same as Ch. 1]. Then the settings will become the 
same for all other channels. 

3. Click the [OK] button to fi nish. 

NOTE:
- If you have chosen fi xed values for all channels, the data graph lines may, under certain circumstances, stick out of 

the graph. Settings for the upper limit must be 40,000 or lower and settings for the lower limit must be –40,000 or 
higher. 

- The values assigned here will be active and used when saving the graph to a fi le. If you wish to have the vertical 
axis scale range automatically assigned, by clicking [Auto] for each channel, the vertical scale will automatically be 
determined and set according to the upper and lower values of the data being viewed. 
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Scale / Unit Conversion: From [Tools] Menu  
It is possible to make settings for the conversion of units and scales for each channel of down-
loaded data.This can be used when no conversion formula settings were made before recording or 
when you wish to make changes to the conversion formula that was set in the Scale Settings Dis-
play. 
In the [Tools] Menu, select [Scale, Unit Conversion] to open the settings window. 

The currently set conversion 
equation and the character 
array of the current unit will be 
displayed. 

[Designate by 2 points] Tab

[Return all 
Conversions] Button

[Designate by y=ax+b] Tab
Example of [Designate by 
2 points] 

[OK] Button

1. Select to use 2 voltage points to convert the scale, by clicking on the [Designate by 
2 points] tab or use the simple conversion equation by clicking on the [Designate by 
y=ax+b] tab. 

2. By clicking the [Return all Conversions] button after making settings for the conver-
sion equation and unit, the settings for all channels will return to those when the 
dialog box was opened.

3. Click the [OK] button to fi nish.
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Changing Graph Colors and Widths of Lines: From [Tools] Menu
It is possible to change the colors of the graph background, the lines, the AB cursors and the width 
of the lines. You can make settings for both display and for printing. In the [Tools] Menu, select 
[Change Graph Colors] to open the settings window. 

[Change Width of 
Graph Data Lines] 
Button

Image Preview

[Memo] setting area

Other 
Buttons

[Change Channel 
Number Color] Button

1. In the "Memo" setting area, select either "Display" or "Print". 
- Click the [Save] button to save the settings, and by clicking the [View] button, you can call up a saved pattern. Here it 

is possible to save one pattern of settings for use in the display and one for use when printing. 

2. Click on the [Channel No.] button fi rst and then click on the topic you wish to make 
changes to. See below for details about each button. 

  [Image Preview]
This area will show the display with the newest settings. An image showing the new settings will appear 
and it can be used to check the graph. 

    [Changing the widths of the graph lines: [ ] Button]
Change the width of the data lines. Please use this feature when printing with a monochrome laser printer 
or any other printer where narrow lines may be diffi cult to see. Each click of the [ ]button will make the 
lines wider and each click of the [ ] button will make them thinner. 

  [Graph] Button
Change the color of that channel's data lines. The standard Windows color selection dialog box will appear. 
Choose the standard color you want or make any desired colors. 

  [Line Type] Button
You can select from fi ve types of lines such as a standard line or a dotted line. (However, if the line has 
been made wider by the [ ] button it will appear as a standard line no matter the setting.) 

  [Background] Button
Change the graph's background color. The standard Windows color selection dialog box will appear. 
Choose the standard color you want or make any desired colors. 

  [Scale] Button 
Change the horizontal and vertical graph scale line colors. The standard Windows color selection dialog 
box will appear. Choose the standard color you want or make any desired colors. 

  [AB Cursor] Button 
Change the AB cursor line colors. The standard Windows color selection dialog box will appear. Choose 
the standard color you want or make any desired colors. 
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   [Scale Value] Button
Change the Scale Value colors. The standard Windows color selection dialog box will appear. Choose the 
standard color you want or make any desired colors. 

   [Default] Button
Returns the colors to the default [Multi-scale Graph] colors.

Print Preview and Print: From [File] Menu
Print Graph / Graph Print Preview
The image of the graph to be printed can be viewed in the Print Preview Display before printing ([File] 
Menu – [Graph Print Preview]). When carrying out printing, click the [Print] button in the Preview window to 
start the printing.  

-The same operation can be done by clicking on the [Print Preview] icon in the Toolbar.

[File] Menu
[Print] Button [Whole view] Button

Display the Data List Preview and Print 
Carry out the printing of a data list by opening the Data List Display.

[Print] Button

1. By right clicking on the [Date / Time] column in the Data List Display, the Menu will 
appear. Click [Print Preview] in the Menu and the [Print Preview (Data List)] window 
will be displayed. 

2. After confi rming, click the [Print] button in the Preview window to start the printing. 
By using the Print Preview Display Toolbar you can change the page being dis-
played, enlarge or reduce the display as desired, and start printing. 
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Saving Recorded Data: From [File] Menu
If necessary, save data. 3 Ways to Save Files.

[File] Menu

  [Overwrite All Data]
The data will be saved without making any changes to the fi le name or location.

  [Save All Data as...]
This will save all edited data into a new fi le. The previous pre-edited data will remain saved as was in the 
original fi le.

  [Save Displayed Data]
This will save only that data in the current display. By slecting this, it is possible to save only the desired 
data.
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Save Data in Text File: From [File] Menu
By saving the recorded data as text fi le, you can create a fi le type that can be read by common 
spreadsheet software. 

1. Click [Save Data in Text File] in the [File] Menu. 

2. Select the [Delimeters] and [Range to be saved], and click [OK].

Comma, Tab, Space, and Semi-
colon are codes used by common 
spreadsheet software, such as 
Excel and Lotus, when reading 
Text File to divide cells. 

Select 
Delimiters

Select Range 
to be Saved

[OK] 
Button

3. Designate the location to which the fi le should be saved and click [Save] to create 
and save the data as a Text File document. File will have extension [.txt]. 

NOTE:
- [Multi-scale Graph] cannot read text type fi les.

Opening a Saved File: From [File] Menu 
Open previously saved fi les. 

1. From the [File] Menu, select [Open Data File]. 

2. Select the name of the data you wish to open and click [Open] to view the data in 
graph form. 

Select a File

[Open] 
Button
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Downloading Flash and Re-installing

To download Flash go to: http://www.adobe.com/
To view Weather Display Live in your browser, it is necessary to have Macromedia Flash Player 
(Version 7 or higher) installed on your computer.  Please install it from the Adobe Macromedia 
Flash Player Website.

NOTE:
- The installation of Flash is completely the responsibility of the user.  Please carry out the installtion by following the 

directions as they appear. 

Re-installing
Before reinstalling or updating the "WS-2 for Windows"software, make sure to carry out the unin-
stall program fi rst. Before uninstalling, make sure to quit all "WS-2 for Windows" applications. 

NOTE:
- To install "WS-2 for Windows", it is necessary to have Administrator rights (Computer Administrator) for the com-

puter in which you wish to install it. 
- Even after uninstalling, saved data fi les will still remain in the folders and locations they were saved in.

1. In the Windows Control Panel, click on [Add or Remove Programs].  

2. From the list of currently installed programs, select "WS-2 for Windows 1.xx" and 
click the [Remove] button. 

Select "WS-2 for 
Windows" 
[Remove] button

[Remove] Button

3. A message will appear, click the [Yes] button to start the uninstalling of application. 

4. Follow the directions to Uninstall.

5.  After the uninstall process is completed, reinstall by following the directions to "In-
stalling the WS-2 for Windows" (See page 21 - 22 for details.).  
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Troubleshooting

Problems  that way occur while running "WS-2 for Windows"
Q.1 The following message appears, [Windows Security Alert], what should I do?

A If you are using Windows XP SP2, the following message may be displayed.  There is no problem, 
so please click [Unblock].

Q.2 Is it possible to use the [WS-2 for Windows] via a proxy server?

A Communication is impossible via a proxy server.  With Web Viewer communication is pos-
sible. 

Q.3 I cannot run a search in the Network Initialization. Why?

A One of the following may be the reason:
- Power is not being supplied by the AC adaptor to the WS-2.
- The WS-2 and the computer you are using are not on the same network.
- The [Network Settings Utility] is already being used by another computer.
- The LAN card which is being used has not been formatted.

Q.4 I cannot make settings in the Network Initialization. Why?

A One of the following may be the reason:
- The Login ID and/or Password are incorrect.
- Another WS-2 with the same IP address is on the same network.

Q.5 Why does a [Communication Error (Connection Error) ] appear?

A The network is probably not properly connected. One of the following may be the reason:
- One of the following is incorrect: IP address or Domain, Login ID, Password, or Port Number.
- The network is not properly connected (the LAN cable is broken, the Hub is damaged, a mistake occurred in 

setting up the router, etc…).
- In the [Menu] - [ Communication Time Settings] try slowing the communication time.

Q.6 Because of some other [Communication Error] communication cannot occur. Why?

A One of the following may be the reason:
- The IP Block setting is ON and communication can occur with only specifi c PC's.
- If after several attempts a communication error continues to occur, turn OFF the WS-2 and restart.
- A warning report mail or test mail is in process. If a sending error occurs, processing takes time, so please 

wait for at least one minute before trying again.

Q.7 Which has priority, a wireless LAN or a wired LAN?

A If a wireless LAN card is inserted, the wireless LAN will have priority. Because of this, if the wireless 
LAN settings are incorrect and a wired LAN is connected, communication will not take place via the 
wired LAN and hence communication will not occur.
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Q.8 I forgot the password, what should I do?

A First, return the settings to the factory default settings and then redo the settings.

Q.9 Is it possible to hide the IP address history and settings history?

A If you wish to hide the History, in the [Menu], select [Login History] and click to [OFF].
Please note that a history will remain viewable from when before it was disabled. To erase a history, 
please click on [Clear Login History] in the Menu.

Problems that may occur with WS-2 Management Settings 
Q.1 I cannot send mail, why?

A If the transmission failed, one of the following may be the reason:
- In the Detailed Network Settings, the necessary gateway address settings have not been made.
- In the Detailed Network Settings, the necessary DNS settings have not been made.
- In the Detailed Network Settings, the necessary SMTP Server settings have not been made.
- Check the ESS-ID for mistakes in upper and lower case letters.
- The SMTP server needs SMTP authentication (May need to change Provider). 
- The SMTP server will not recognize the Sender Address (May need to change Provider). 
- The necessary POP before SMTP settings have not been made.

Q.2 I cannot connect to a wireless LAN. Is there a way to check the wireless LAN status?

A Unfortunately, there is no way to check. But you can check the following:
- Is the ESS-ID or WEP key code incorrect?
- Are you using a Wireless LAN card other than the ones we endorse?

Q.3 I tried using a different wireless LAN card and now I can't get communication to 
work, what happened?

A Even if all settings remain unchanged, after putting in a different wireless LAN card and restarting, 
communication will no longer be able to occur.
That is because the MAC address of the previously used LAN card is still in the APR table in your 
computer.
In order to communicate using the new LAN card, you can either erase the APR table or reboot 
your computer.

Q.4 I forgot the password, what should I do?

A First,  By pressing the "RESET" button, return the settings to the factory default settings and then 
redo the settings.
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FAQ's

Q&A about WS-2
Q.1 WS-2 units use an AC adaptor, what happens when there is power shortage?

A During a power shortage all functions will be stopped. Therefore, the Web Server and Warning Functions will 
also be disabled. However, because the settings will remain in the WS-2, by turning the system on, operation 
will continue with the same settings.

Q.2 Can I connect directly to my computer with the LAN cable that comes with the log-
ger?

A To connect a WS-2 directly to your computer, you must use a cross LAN cable.
The LAN cable supplied is a straight LAN cable and cannot be used to connect directly to your com-
puter.
Please purchase a LAN cross cable at your local computer supply store.

Q.3 Does the WS-2 have a clock and calendar?

A Because the WS-2 clock settings are automatically received from the Weather Station, make sure that the 
Weather Station's date and time settings are correct. 

Q.4 If several WS-2 are connected to the same router, how can I identify which is which?

A If two or more WS-2 are connected to the same router, it is possible to identify by setting each with 
an individual IP address and from the Internet side can be identifi ed by the port number to which it 
is connected.

Q.5 Where can I set the port number?

A The port number can be set from the [WS-2 for WIndows].
Under normal conditions, for HTTP communication the setting is 80, but if you wish to synchronize 
the settings to match the router settings, it is necessary to change the settings for the WS-2 and for 
the router.

Q.6 It is possible to connect the WS-2 to the network by using the LAN cable that con-
nects the computer to the LAN network?

A Inserting the wireless LAN card that connects the computer to the network into the WS-2 will physi-
cally connect the WS-2 to the network, but without making the necessary settings such as IP ad-
dress, the WS-2 cannot be active in the network and hence is not really connected.
After having inserted the LAN cable, make sure to go to [WS-2 for Windows] to make the necessary 
IP address and subnet mask settings.
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Q&A about Web Server Functions
Q.1 Is a WS-2 unit a web server?

A The WS-2 units have web server functionality built into them. This function allows for the provision or 

serving up of temperature and humidity data, current readings and graphs.

Q.2 What is a Web Server? What is a client?

A In a computer network, the computer that acts as a provider of services to various users is called a 
server and the computers which request these services from the server are referred to as clients.
Most communication service is made up of exchanges between servers and clients.
In the case of WS-2, the WS-2 provides functions and information so it is a server and the computer, 
which reads this information or functions, is the client.
For example, the storage of web sites and the making public of these are done by the [Web Server] 
and the sending and receiving of e–mail is performed by the [Mail Server].

Q&A about Networks
Q.1 What is a Network?

A A network is a system in which a group of computers are connected by cable (copper wire, optical 
fi ber, etc), infrared ray, radio waves or other means in order to share and exchange information.
There are basically two types of computer networks.

 - LAN (Local Area Network)
   A Local Area Network or LAN consists of a group or network of computers in a limited range. 

 - WAN (Wide Area Network)
   A Wide Area Network or WAN is a network of computers that are connected over long distance.
   The Internet is an example of a WAN that has connected a multiple number of networks. 

Q.2 What is an IP address?

A In a network, in order to distinguish your computer from another it is necessary to assign a number; 
this number is called an IP address.
When you connect to an outside network such as the Internet, the IP address that is used is referred 
to as a "Global IP address". In a Local Area Network the IP address that is used is called a "Private 
IP address".
An IP address is divided into 4 blocks of numbers separated by periods, such as "192.168.15.10". 
The assigned numbers can use the digits 0-255 with private IP addresses usually beginning with 
numbers such as "192.168.".
* However, the number "255." is not usually used.
   This number is absolutely necessary to enable participation in a network, so it is necessary to set the IP 

address to a number that suits your network environment.
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Q.3 What is a subnet mask?

A An IP address is made up of the network address to which the computer belongs (network address) 
and the computer's own address within the network (host address). The subnet mask determines 
the division between these.

The subnet mask, similar to the IP address, is made up of four blocks of numbers divided by 
periods, such as "255.255.255.0".
This number is absolutely necessary to enable participation in a network, so it is necessary to set 

the subnet mask to a number that suits your network environment.

Q.4 How should I make settings for the IP address/subnet mask?

A The IP address and subnet mask settings vary depending upon your networking environment 
(structure). Please consult your network administrator for details. Below is a simplifi ed explanation 
for your reference.
If the computer connected to your company LAN has a subnet mask of "255.255.255.0" and an IP 
address of "192.168.100.1", set the subnet mask to the same as your computer, "255.255.255.0".
Set the IP address to 192.168.100.***. Make sure to set the last three digits,***, to a number 
between 1-254 that is not the same as any other computer connected in your network.

Q.5 What is a MAC address?

A A MAC address is a unique number made up of alphabet and numbers that is assigned separately 
to the components of network communication (computer, server, router, etc…). Each MAC address 
is assigned to the hardware and is unique to that device, so there is no chance for duplication.
If you compared it to a cell phone, even though the phone number may be changed, you could think 
of the MAC address as the serial number of the phone, which cannot be changed and is unique to 
each unit.
The MAC address is written on a sticker on the back of each WS-2.

Q.6 What is a port number?

A When using TCP/IP communication with a LAN cable or via a phone line, port numbers are 
assigned to distinguish one application from another.
Port numbers can be assigned from 0 to 65535. The numbers 0 to 1023 are already reserved to 
communication services and are referred to as [Well Known Port Numbers].
[Well known port numbers] are: HTTP communication at 80/FTP communication at 20 and 21/
SMTP communication (sending mail) at 25/POP3 communication (receiving mail) at 110.
In order for communication to work properly these port numbers must be set correctly.
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Q.7 What is a gateway?

A A gateway is a term used to refer to a device or software that is used to link networks with different 
standards.
For example, a gateway is needed when connecting a cell phone to the Internet or in any case 
where you wish to connect two devices that are completely different. Gateway carries with it the 
meaning of entrance and exit and a router may also be referred to with this term.
When making gateway settings, it is necessary to make IP address settings for the device that will 
act as a gateway.

Q.8 What is a URL?

A A URL is an address that is written in a way so that it is easy for the DNS function to determine on 
which server the IP address is located.
This address begins with "http://" and is followed by such things as domain names, server names, 
port numbers, fi le names and other such info.

For example, if the IP address that is assigned to "www.tandd.co.jp" is "61.197.203.107", by 
entering "http://61.197.203.107/product/ws2/index.php" in the browser, the same page will appear 
as when you enter "http://www.tandd.co.jp/product/ws2/index.php".

* The DNS or Domain Name Server helps to switch diffi cult to understand IP address of just numbers, such 
as "61.197.203.107" into easy to grasp names such as "www.tandd.co.jp" and helps connect to the desired 
server.

Q&A about the Internet
Q.1 What is an IP address?

A Usually, when you connect to the Internet, the provider with which you have contracted service 
automatically assigns an IP address which may be different each time you connect, or may change 
after a certain length of time.
With this type of changing IP address, it is more diffi cult for outsiders to illegally enter your computer. 
On the other hand, when using your computer or a WS-2 unit as a sever, it would be necessary to 
enter a different IP address as the URL each time you wish to access it. In such a case, it would 
be necessary to fi nd out the current IP address each time you wished to access and this would be 
totally inconvenient.
To help solve this problem, there is something called a fi xed IP address service that your provider 
can offer.
With a fi xed IP address, you will be assigned a special unique IP address.
Some providers may give you a fi xed IP address from the beginning of service, but with most 
providers it is necessary to sign up for this special service.
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Q.2 How do you get a fi xed IP address?

A A fi xed IP address is a service offered by your Internet provider.
For details about how to receive a fi xed IP address contact the Internet provider with which you are 
connected.

Q.3 How should I set up a fi xed IP address?

A WIf you wish to open the WS-2 via the Internet, you must set the fi xed IP address to the router and 
not to the WS-2. The fi xed Internet IP address should be assigned to the router and all access to the 
WS-2 from outside should go through the router. 
The router will have two IP addresses: an external IP address for the Internet and an internal IP 
address for the company or household LAN.

Q.4 I want to use a URL without a fi xed IP address, how can I do that?

A If you wish to access a WS-2 by URL but without a fi xed IP address, it is possible to use a dynamic 
IP address.
The DNS or Domain Name Server helps to switch diffi cult to understand IP address of just numbers, 
such as "61.197.203.107" into easy to grasp names such as "www.tandd.co.jp" and helps connect to 
the desired server.
The DNS usually changes names to fi xed IP addresses.
But, if for some reason you cannot use a fi xed IP address or for security reasons you wish not to use 
a fi xed IP address, there is a type of DNS called a dynamic DNS, which can handle ever-changing 
IP addresses.
For example, the starting IP address is "210.0.0.1" and the URL associated with it is "http://www.
ws2.com".
The IP address "210.0.0.1" is of the changing type that is periodically reassigned by the provider. 
After a certain period of time the assigned IP address is changed to "210.0.0.2".
Normally, at this point the DNS would not associate the URL with the IP address and access would 
be made impossible, but because the dynamic DNS tracks the IP address you can still access the 
desired server using the same URL.
There are many types of dynamic DNS plans and services available, please contact your local 
provider for more details.

Q.5 Can I use the Warning Mail function without getting or using a fi xed IP address?

A Theoretically it is possible to send mail without having or using a fi xed IP address. That is presuming 
it is possible to successfully send data via your provider's mail sever or your company's mail server. 
Fundamentally, if you are able to access your company mail server or connect to the Internet it 
should be possible to send mail. 
It should be noted that a Mail Server which requires authentication other than POP before SMTP cannot be 
used.  
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Q.6 Is it possible to connect to the Internet without a fi xed IP address nor an URL?

A Yes, it is possible to connect without using a URL or having a fi xed IP address, but because the IP 
address that will be assigned by the provider will be constantly changing, the access will be varied 
and will not go smoothly. 
For example, the IP address that you used successfully one hour before may no longer work and 
access will be made impossible. Further, you will have no way of verifying the new IP address. 
We strongly suggest using either a fi xed IP address or a dynamic DNS.

Q.7 If I connect the WS-2 to the Internet, is it not possible that another person could read 
my data or change my settings?

A Yes, as long as you are connected to the Internet, the unit could well be the target of unwanted ac-
cess. 
But as long as your password and ID have not been leaked or stolen, it will be impossible to access 
the most important areas. 
But be aware that there are no assurances that your password and ID will not be stolen. If you wish 
to lessen these risks we strongly suggest that you install a fi rewall and other security software into 
your network.

Q.8 What is POP Before SMTP?

A POP Before SMTP is one method used for the sending and receiving of mail.
A mail server uses two types of protocol to send and receive mail. Generally when mail is sent it 
uses an SMTP server and when receiving mail uses a POP server. 
Normally, the sending and receiving of mail are done separately. However, recently in an effort to 
fi ght Spam mail a new type of mail server, referred to as POP Before SMTP, has appeared. 
The way it works is that after logging in your Login ID and password to the POP server you can ac-
cess the SMTP server for a certain length of time in order to send mail. 
Due to the particularity of this method, the WS-2 mailing function has been designed to be compat-
ible with POP Before SMTP.

The WS-2 mailing function has been designed to be compatible only with POP before SMTP.
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Specifi cations
Hardware

Product Name Network Server for Weather Station: Weather Wing WS-2 

Interface Specifi cations      Serial: 

LAN: 

CF:

RS-232 D-SUB 9 pin Connector 

IEEE802.3  10Base-T/100Base-TX 

Possible to use with IEEE802.11b Wireless LAN Card (PRISM2.5/3.0) 
*  Although it is possible to be used with either Wireless LAN or 10/100Base-TX, it is impossible to use simultaneously with both.  

Communication Speed 19200bps / 9600bps

External Output Contact Output Capacity: Max AC/DC50V 0.1A

Warning Output Voltage when OFF: AC/DC less than 50V  

Current when ON: less than 0.1A  ON Resistance: MAX 35     

Power AC Adaptor AD-0605 or AD-0609

Dimensions / Weight of Main Unit H83×W102×D28 mm(excluding protrusions) / about 35g 

Operating Environment Temperature: 0 to 50 ,  Humidity: 20 to 80%RH (No condensation) 

Accessories included in package AC Adaptor (AD-0605 or AD-0609) x1,  LAN Cable (LN-20W) x1, Software Set x1, 

Introductory Guide (Warranty) x1 

Weather Display Live

Management Functions  

Warning Settings : Warning Items (Barometric Pressure / Humidity / Temperature / Rainfall / Wind Speed) 
Warning Function (Enable / Disable) , Upper and Lower Limit Settings (Only upper limit for Wind 
Speed and Rainfall) , Sending E-Mails, Output (Pulse / During Warning) , E-Mail Recipient Address 

 Data Transfer Settings : FTP Upload (FTP Server Name/ Upload Path Name / Transmission Interval) 

E-Mail (Transmission Interval / Attaching Log File / Recipeint Address) 

Other Functions : Communication Speed,  Assinging Device (Station) Name, Refresh Interval 

Checking Settings (All Basic Network Settings / E-Mail Settings / Wireless LAN / Port Numbers / 
Communication Port / System Information) 

WS-2 for Windows

WS-2 Settings Utility WS-2 Settings Utility , Network Initialization,  Detailed Network Settings,
Login History (ON / OFF) , Clear Login History,  Communication Time Settings

Multi-scale Graph Graph : Data Graphs for every Channel (Data allocated to Channels 1 to 7) 

(Zoom in/out and scroll with mouse) 

Data : Channel Data Name,  Recording Interval,  Number of data,

Cursor AB position data, Scale / Unit Conversion,  Highest / Lowest / Average Reading and Total 
Number of Readings in Calculation Range 

Others : Data List Display,  Delete Data, Re-order Data,  

Change Display Colors and Width of Data Lines for Channels, 

Merge Channel Data, View and Hide Channels , Set Vertical Axis Display Range, 

Scale / Unit Conversion,  Change Graph Colors and Line Types / Widths, Edit Recording Condi-
tions, Vertical Axis Settings, Creating Text File

PC Operating Environment 

Compatible OS Microsoft Windows 2000 / XP/ Vista  English  
*  To install the Settings Utility, it is necessary to have Administrator Rights for the computer into which it will be installed. 

PC / CPU

Memory  

Hard Disk 

Monitor

LAN 

Web Browser

A Stable Windows Operating Environment

LAN, TCP/IP Communication Possible

Enough memory to stably operate Windows 

More than 10MB free space(Data will need more space)

SVGA (higher than 800×600 recommended) / more than 256 colors 

100BASE-TX or 10BASE-T / Twisted pair cable conforming to Category 5(STP/UTP)

Internet Explorer 6 or higher / Fire Fox 2.0 or higher
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Optional Accessories 

Wall Attachment
TR-5WK1  

Wall Attachment x 1

Screws x 2

Double-sided Tape x 1

[Unit: mm]  
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